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Preface

Computer

: Computers is a comprehensive series of eight books designed specifically

for the needs and requirements of the students studying in classes 1-8. This
series perfectly complies with the NCERT syllabus criteria and the National
Curriculum Framework's vision. In keeping with NEP 2020’s guidelines, the
series adopts an interactive approach to make it possible for the learners to
enjoy computers. This book includes enough questions in accordance with
the NEP criteria. The fundamental principles of NEP which are recognizing,
identifying and fostering the unique capabilities of each student, respect
for diversity, and consideration for the local context in all topics, are always
kept in mind while framing the book.

The topics are introduced in a way that children experience and learn
through exploration.

Child-friendly language and contextual images have been incorporated
throughout the series to make the material more understandable for young
readers. This allows them to connect what they read and relate it to the
views, ideas, and experiences they encounter every day.

Salient Features of the series:

Learning Outcomes

Warm Up
Teacher’s note
Let me answer

Do You know
Remember It

Kids’ IQ

Up skill your
Intelligence
Critical Thinking
Team Work

: It guides both the teacher and the students towards the correct direction

of efficient learning. It establishes the path of learning for efficient and
superior learning results.

: Children can connect their prior knowledge to the chapter's topic through

simple yet engaging activities.

An outline of guidelines for teachers to follow in the classroom in order to
make lessons interactive and discussion-based.

: Questions related to the topic which are essential for checking pupil

understanding and keeping them engaged with the task at hand.

: An interesting piece of information related to the topic.

: Additional information about the topic to encourage children to wonder

about various surroundings.

: These questions have been included to reinforce learners to think,analyse

and apply.

: Ample exercises with a range of questions to support learning.

: Questions which allow the learners to think clearly and rationally.

: It enables the students to collaborate with others.

The content is structured and well graded. Sincere efforts have been made
to prevent any inconsistencies and make this series a perfect complement
to the students' education. Any worthwhile recommendations for the
improvement of the series are always welcome and greatly appreciated.

Author
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Learning Outcomes

It shows the right path of learning
to the teacher as well as students. It
establishes the direction of learning
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for efficient and superior learning
results.

Warm-Up

Children can connect their prior
knowledge to the chapter's topic
through simple yet engaging
activities.
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Teacher’s Note:

An outline of guidelines
for teachers to follow in

—

the classroom in order to
make lessons interactive
and discussion-based.
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Remember It

Additional information about the

topic to encourage children to wonder
about various surroundings.

Kids' IQ
These questions have been included

to reinforce learners to think,analyse
and apply.

It aids in providing a brief summary
of the entire chapter.
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COMPUTER NETWORK

At the end of this chapter, the students will be able to:
+ Know about computer network

+ Learn different types of networks

+ Identify the advantages of a computer network

BTN Elucidate students that it is impossible to go through a day without the use of communication.
t\j (\[({: Both the sender and receiver require a medium to communicate.

Computer -8
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Hey Friends! Let us
learn about computer
networks.

We frequently discuss our feelings, opinions, and favourite things with our friends . Similarly,
two or more computers must be connected in order to share information. A computer
network is made up of two or more computers that are connected to one another through
various communication channels. These computers are all linked together in such a way
that they can occasionally exchange data and hardware resources.

% THE NEED FOR A COMPUTER NETWORK

An organisation can benefit greatly from a computer network in a number of ways. Here are
some advantages of a computer network.

Saves Cost

We have learned how all the computers are connected to a single network and can share a variety
of hardware resources. There is no requirement to purchase several items as a result of this. For
instance, a single modem can be used to link a variety of networked devices to the internet.

Reducing Data Redundancy

Imagine that an organisation has 100 employees, and every single one of them wants to work
on the same file. One approach is to keep separate copies of the same file on each computer.
Data duplication or redundancy will result from this. The alternative is to connect all of the
computers over a network and store a single copy of the file on a main computer, allowing

the other networked computers to access the file as needed.
gl

|

- -
| [

Sharing Resources

Information or data, software
applications, and hardware
components make up resources.
These resources can be shared
across computers that are
connected through a network.

For instance, a single computer with Figure 1.1: Sharing Resources

Computer -8




a printer attached may exist in an organisation. All the other computers that are part of the
network can use the network services of the same printer.

Security

As more computers communicate information via a network, security becomes increasingly
important. This can be done using a variety of methods, including setting up a firewall
system and other network protection tools that are available across many platforms. This
aids in the fight against phishing and data thetft.

<4 TYPES OF NETWORKS

Computer networks can be characterised by their size as well as their purpose. There are
different types of computer networks depending upon the number of devices that are
connected together.

The size of a network can be expressed by the geographic area they occupy and the number
of computers that are part of the network.

Personal Area Network (PAN)

A computer network set up just for an
individual inside a compact building is
known as a personal area network. This
may take place in a small workplace or
house. PAN generally covers a range of
up to around 10 metres. A PAN would
typically consist of one or more computers,
phones, including mobile phones, printers,
video game consoles, and other personal
entertainment devices.
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Figure 1.2: PAN

% Do You Know?

The main role of PAN is to eliminate cables
that connect devices to peripherals.

Local Area Network

The Local Area Network is confined to
a limited area, such as a room, an office
building, or a school, or a college campus.
As the area covered by LAN is limited, the
data transmission speed in LAN is very fast

s8] =]
<

-
¥ —

Figure 1.3: LAN
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and can be easily maintained. In LAN, wires are used to physically connect the computer
terminals. WLAN refers to local area networks where computers communicate wirelessly.

Metropolitan Area Network ( MAN)

A metropolitan area network consists of a computer network which covers an entire city,
college campus or small region. As compared to LAN, it covers a wider area. A MAN
network’s computers can be linked together using both wired and wireless communication
methods. ATM machines of a specific bank, installed at different locations in a city, are an
example of MAN.

=

Figure 1.4: MAN

Wide Area Network

A wide area network occupies a very large area, such as an entire country or the entire world.
It consists of many smaller networks, such as LANs or MANs. The primary characteristic of
WAN is that data transfer requires a public telecommunications medium. A very common
example of WAN is the internet, wherein millions of computers are interconnected with
each other.

% NETWORK TOPOLOGIES

The organisation of diverse network components in a way that makes communication
simple is known as network topology. Before you start with the arrangement of network

O
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components, It’s crucial to establish the logical topology—also known as the information
flow between network components.

Network topologies are categorised into the following basic types:

Point-to-Point

This topology is among the most widely used since it is simple to utilise. Direct
communication between two network components, such as PCs, routers, hubs, etc., is
established using this method. Both wired and wireless technologies can be used to create
a direct link.

Bus Topology

Bus topology, also known as line topology,
is a type of network topology in which all
devices in the network are connected by one
central network cable or coaxial cable. The
single cable, where all data is transmitted

between devices, is referred to as the bus,
backbone, or trunk.

There are two types of bus topologies: Figure 1.5: Bus Topology

< Linear bus topology. All devices are connected to a single

LRE ]

cable with two endpoints. =¥,
A host on a bus network is

called a station.

< Distributed bus topology. All devices are connected to a

single cable that branches oft into multiple sections, resulting
in more than two endpoints.

Star Topology

In a star topology, the central hub acts like
a server and the connecting nodes act like
clients. When the central node receives data
from a connecting node, it can pass the
data on to other nodes in the network. A

star topology is
also known as @ Let Me Answer
What do you mean by Star
a star network. Topology?
In this topology, Figure 1.6: Star Topology

Computer -8




it is easy to add a new device to the network with the help of only one cable. The entire
network goes down only if the central computer/hub fails.

Ring Topology

Each computer in a ring
topology is connected to
the one behind it in such a
way that when they are all
put together, they resemble
a shape of ring. When one
node sends a message to
the other node, which is not
adjacent to it, the data travels
through all the intermediate
nodes, until it reaches its final
destination. The data in this
topology has to pass through
each connected computer;
this makes it slower than the
other topologies. Figure 1.7: Ring Topology

Tree Topology

A tree topology is a sort of

structure in which each node
is related to the others in a
hierarchy. In a topological
hierarchy, there are at
least three distinct levels.
Sometimes it is also called
hierarchical topology as in
this topology, all elements are
arranged like the branches of

atree.Inatree topology, there
can only be one connection
between any two connected

@ Let Me Answer

Flgure 1.8: Tree Topology

computers. For database-related services or to organise the
computers in a large cooperative network, the tree topology
is commonly utilised. In this topology, the expansion of

o

How is Tree topology related to
a tree?
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network is feasible, and an easy task to carry out, but the maintenance of the same is often
difficult.

Mesh Topology

Computers are joined

randomly in a mesh network E
structure. Each computer in

the network can transmit a lE

signal to the other computers
in this sort of topology, and
each computer also assists in

retransmitting data to other E..

computers in the network. """“'---..IE
It is a topology commonly =

used for wireless networks. Figure 1.9: Mesh Topology
The cost is too high for maintaining this type of network.

Peer-to-Peer Network

In the simplest terms, a peer-to-peer network is a network created whenever two or more
devices (usually a computer) are connected and share resources available on the web. Each
computer can act both as a server and a client as there is no central server in this network.

= — TN = B
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Figure 1.10: Peer-to-Peer Network

o
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Client-Server Network

Several Computers called clients are connected to the main computer called the server in
this network. A computer that serves clients and manages access to hardware, software, and
other resources is known as a server. The computers that ask the server for services like data
retrieval, storage, etc. are known as clients.

<

« N[

Figure 1.11: Client-Server Architecture

L= Kids’ 1Q

Shivani wishes to link the electronic devices of her entire family with each other. Give
Shivani and her family a network type that will work for them.

! Let’s Recall

An organisation can benefit greatly from a computer network in a number of ways.
o  Computer networks can be characterised by their size as well as their purpose.

o A computer network set up just for an individual inside a compact building is
known as a personal area network.

o A wide area network occupies a very large area, such as an entire country or the
entire world.

« A tree topology is a sort of structure in which each node is related to the others in
a hierarchy.

o In Client-Server Network, several Computers called clients are connected to the
main computer called the server.

o

Computer -8




pskill Your Intellig

A. Fill in the blanks.

1. Asingle........ can be used to link a variety of networked devices to the internet.

2. Information or data, software application, and ............. components make up
resources.

3. Setting up firewall system aids in the fight against ............... and ................
Computer networks can be characterised by their ............... aswell as their...........
The size of a network can be expressed by the ... area they occupy.

B. Write ‘T’ for True statements and ‘F’ for False statements.

1. A computer network setup just for an individual inside a compact
building is known as wide area network.

PAN generally covers a range up to 10 metres. ()
The data transmission speed in LAN is very fast. ()
MAN stands for Metro Area Network. ()

Bus topology is also known as line topology.

N o

C. Answer the following questions.

1. Why is there a need for a computer network?




5. Explain Wide area network. (WAN)

{}\ Critical Thinking

E3
Identify the following topologies.

== = | T &
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At the end of this chapter, the students will be able to:

+

+

+

Prepare a Telephone directory and address book of your friends.

Comprehend the concept of Database
Learn the advantages of DataBase Manager
Know the components of Access

Create a Database

Identify views in Access

Insert/delete field in Datasheet view

Name Phone Number

LOG ON TO ACCESS

Address

Guide students that it is very difficult to maintain this data manually when there are hundreds
and thousands of records, as the chances of committing errors increase. Telephone directory, a
dictionary, list of groceries in a grocery store are the examples of different types of databases.

Computer -8
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Hello Friends! Lets
learn how to arrange
data in databases.

-

The use of data is essential in advanced technologies. Today’s most well-known apps and
websites rely on data. Data is essential for organisations and institutions when creating
strategy. Government also depends on data for decision-making and for creating favourable
policies for the people of the country. The data needs P
to be stored in an organised way to allow for easy < 4 Do You Know?
access and accurate information retrieval. Databases | On November 13, 1992, the first version of
are used to organise the data in this manner. MS Access was released by Microsoft.

@ DATABASES

A structured collection of information about an entity is what is meant by a database.
Databases make it simple and efficient for users to add, access, modify, and delete data.
A database may sometimes be regarded as a storage location for data. For example, an
organisation can create its own database to store the personal records of their employees.
The database system uses a hierarchical structure to store the data. A system that supports
the organising of data is called Database Management System. (DBMS)

The way data is kept in a database is shown in the following diagram.

Database

Tables

Data

Computer -8




% ADVANTAGES OF DATABASE MANAGEMENT SYSTEM

Control Of Data Redundancy

A computer’s memory is a crucial component. Memory is wasted as a result of redundancy.
DBMS offers a number of methods to check for data redundancy.

Application ID Name Percentage School Allotted
23456 Shruti 79% DPS
23457 Shivani 78% APS
23456 Shruti 79% DPS

You can observe that the record of Shruti is entered twice. This may lead to wastage of
memory.

Maintaining Data Consistency

Data consistency is the management of data across many database tables, particularly when
the data in these tables is related to one another.

Table 1 Table 2
Application ID Name Application ID Percentage
23456 Shruti 23456 79%
23457 Shivani 23457 78%
23456 Shruti 23456 79%

Sharing of data

One computer’s data can be shared among numerous users with DBMS.

Data Integrity

Data integrity guarantees that the database only contains relevant information. For Example,

an organisation database should have data related to employees and clients.
Computer -8
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Computer -8

S WHAT IS MICROSOFT ACCESS?

Microsoft Access is the most popular and powerful RDBMS ( Relational Database
Management System) that serves an integral part of the Microsoft Office Suite Application.
It has a graphical user interface. It is employed to effectively organise and manage massive
amounts of data. It organises data in the form of tables. Data duplication can be avoided
with a relational database. Access also allows you to add, update, delete, and view data using
forms. Further, it helps to find and retrieve the data in a desired way by using queries, and
print the data in a specific layout by using reports.

Components of Microsoft Access 2016

Let’s familiarise ourselves with the various parts of the Microsoft Access window.

Quick Access Toolbar Tabs Title Bar Tell me what you want to do
i e A
|
Ribbon
Object Tab
Quick Access
Toolbar
Navigation
Pane
Work Area
o Status Bar View Buttons
Navigation

Pane

Figure 2.1: Components of Microsoft Access 2016
Title Bar

The name of the current database is displayed on it, which is at the top of the window.

Quick Access Toolbar

This toolbar can be found in the Access window’s upper left corner. It has the command
buttons that are used the most. It comes with three buttons by default: Save, Undo, and

Redo.
20,
-




Ribbon

It has numerous tabs, each of which has a number of groups of relevant commands. Some
tabs appear when you work with certain objects like Forms. Such tabs are called Contextual
tabs.

Tell me What You want To Do

It's a brand-new tool that you may use to find quick information on subjects you're interested
in or commands you wish to utilise in your document.

Navigation Pane

This pane is present on the left side of the Access window. It displays the name of the Access
components used in the database,e.g. Table, Forms, Queries, Reports, etc.

Record Navigation Buttons

As the name suggests, it helps in navigating through the records. The navigation button
displays the current record number in an object.

Object Tabs

The object tabs resemble the tabs found in web browsers. It displays the elements you've
opened in tabbed form. The contents of the components in the Work area are displayed
when you click on any tab.

Status Bar

This resembles the buttons we use in PowerPoint to select from

@let Me Answer

) o o ) Can you tell which software is
the current view and on its right, it displays four view buttons, | similar to Access 2016?

the different views. On its extreme left, it displays the name of

which are Datasheet view, Design view, PivotTable view and
PivotChart View,

=4 CREATING A DATABASE

Using a template or starting from a blank database are the two approaches to create a database
in Microsoft Access. An access template helps in creating a complete data application which
is ready to use. It contains four main objects like tables, queries, forms, reports,etc that you
need to perform a specific task.

Computer -8




Creating a Blank Database

Follow the given steps to create a database from scratch.
Steps:
1. Click on the Blank database option.

Figure 2.2: Blank Database
2. Click on the Blank database option.

MNew
b
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Blank database
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Figure 2.3: Blank Desktop Database

e

3. Click on the Blank database option.
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Creating a Table In Design View

The Design view window’s structure can be seen in the following image.
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Figure 2.4: Creating Table in Design View

Steps:
1. In the Field name, add a column name for the table.
2. Select an appropriate data type for the field from the Data Type drop-down list.
3. Add the text in the description to enter a few more details about the field.
4. Save the table by clicking on the Save option in N

the File tab.

REMEMBER IT!

Access 2016 offers ready templates for
regular users to create and publish data.

Creating Table with Datasheet View

Click the Create tab and choose the table button
from the Tables group to create a table in the Datasheet view. This will create a new blank
table. The table will open in the Datasheet view.

Steps:

1. Click on the “Click to Add” label. Observe that the icon in the row selector changes to
a pencil. This means that changes were made to the record but they weren't saved. The
asterisk (*) sign moves to the next row.

2. Enter the data.
Press the tab key after each entry

Click on the Save icon present on the Quick Access toolbar to save the table.

e
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Figure 2.5: Creating Table with Design View

Data Types In Access
The following table depicts the available data types in Access 2016.
Data Types Functions
Short Text It is used to store text or a combination of text and numbers. The
fields with this data type can have a maximum of 255 characters.
Long Text It stores text and numbers up to 65,536 characters. It is used for
descriptive fields.
Number It is stores numeric information that we can use for calculations.

The maximum size of a number field can be 16 bytes. It can store
both integer values as well as decimal values.

Date/Time It stores date and time values. The maximum size used by this data
type is 8 bytes.

Currency This data type is used to store financial data up to 8 bytes.

AutoNumber It generates a sequential number whenever a new record is added

to a table. The value in the AutoNumber field cannot be changed.
It stores data as 4-bytes.

Yes/No It is used at places where the field can have only one possible value.
It can either be True/False, Yes/No.
OLE Object This is used to embed an object created in another application, such

as Microsoft Word document, Excel spreadsheet, or PowerPoint
presentation, into the Access table. It stores upto 2 GB of data.

Computer -8 ?




Hyperlink The Hyperlink data type can store links to web pages, websites,
files on an Intranet or LAN on your computer. It stores up to 1 GB
of data.

Attachment The data type allows you to attach images, spreadsheet files,
documents, charts, and other types of supported files to the
records in your database.

Calculated This data type is used mostly in case of queries, forms, and tables
that generate data from calculations performed on fields of a table.

Lookup Wizard A Lookup wizard helps you to create a field whose values are

chosen from the values in another table, query or list of values. By
default, Access sets Lookup fields to the Number data type.

4

FIELD PROPERTIES

A field property applies to a particular field in a table and defines the characteristics of that
field. The field properties are used to define how a field can behave when data is added to
the field.

The following table shows a list of properties used in Access:

Field Property Description
Field Size This property is used to specify the maximum size a Field can
hold.
Format This property specifies the format of data a Field can hold. For

example, there can be different formats for date and time.

Input Mask It specifies the pattern for the data to be entered in a field. For
example, you can choose the input mask for a password field as *.

Caption The Caption property specifies a column heading for a field. It
is shown whenever a Field is displayed in Datasheet View. It can
hold up to 2,046 characters.

Default Value The Default Value Property to specify a value that is automatically
entered in a field when a new record is created. For example,
Delhi can be a default value for the city field.

Validation Rule This sets a rule for a range of values that can be entered into a
field. For example, marks>50; the marks field will only accept

values greater than 50.

e




Validation Text

Required You can use this property to specify if a value is required in a
field. It accepts two values, Yes and No. Yes, it means a value
needs to enter, and No means it can be left blank.

@ PRIMARY KEY

Primary key is a standard feature of every database management
system which is used to identify each record of a table uniquely. @ Let Me Answer
The field which is designated as the Primary key of a table |Ca” e leave the primary key
neither can have duplicate data nor it can be left blank while blank

entering the data.
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Figure 2.6: Primary Key
Follow the given steps to set the Primary Key.

Steps:
1. In the design view, click on the field you wish to set as the primary key.
The selected field will be highlighted.

2
3. On the toolbar, click on the Primary Key.
4. Save the table.

. Kids’ 1Q

Shobhit has been given an assignment to add a new table in the existing database.
Which option should he use to complete the task?

o
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@ Let’s Recall

Microsoft Access is the most popular and powerful RDBMS ( Relational Database
Management System) that serves an integral part of the Microsoft Office Suite
Application.

o Data duplication can be avoided with a relational database.

o ‘Tell me What You Want To Do’ is a brand-new tool that you may use to find quick
information on subjects.

o  The object tabs resemble the tabs found in web browsers.

o Afield property applies to a particular field in a table and defines the characteristics
of that field.

g

~
A. Fill in the blanks.
1. The use of data is essential in .................... technologies.
2. Governments depend on data for .................. and for creating favourable policies
for the people of the country.
3. are used to organise the data in an organised way.
4. A database can sometimes be regarded asa ... for data.

5. DBMS offer a number of methods to check for data redundancy.
B. Write “T” for True statements and ‘F for False statements.

1. A system that supports the organising of data is called Data Base
Management system.

2. A computer’s memory is not necessarily important.

Data integrity guarantees that the database only contains irrelevant
information.

One computer’s data can be shared among numerous users with DBMS. ()
5. Microsoft access is the most popular and powerful RDBMS. ()
C. Answer the following questions.

1. What is Microsoft access?




2. Describe the components of Microsoft Access 2016.

----------------------------------------------------------------------------------------------------------------------------------------------

{}\ Critical Thinking

E3
Find out five components of Microsoft Access.

wW S U T A T S A T Y
D F G H J C K L O P
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A R I B S B D T X M
G R I B B O N C C K
N A V I G A T 1 O N

Team Work

Team up with your lab partner and create the following table in a database named

My grades.
Grades
< English < Hindi <  Maths < Social Science
< Business < Maths <  Science

?




A3 WORKING WITH QUERIES,
0@ FORMS AND REPORTS

At the end of this chapter, the students will be able to:
+ Learn the importance of Queries, forms and Reports in Access 2016.
+ Create forms, queries and reports in Access 2016.

Fill the following Application form.

Customer Application Form

Name of Company

Full Postal Address *

Details of Applicant

Previous Full Postal Address

A (T Apprise students that forms help an individual or organisation to get detailed information about

t\j [\[({: M a person, event, or an object.
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Hello Friends! Let us
learn to create Forms,
Queries and Reports.

A form is a device for gathering data in a sequential style. Frequently, whoever creates the
form has all the necessary fields for required data.

Forms actually make the process of entering data a lot convenient and simple. Forms make
sure the proper data is entered into the table in the proper format.

We should be aware that the form is related to the table. This implies that the values entered
into a form are kept in a table. Let’s learn to create forms in Access.The presence of an
operational database and a table is one of the requirements for

pere . e @ Let Me Answer
building a form in Access. If a database or table is not present, we :

) Have you ever filled in any

can first construct one. Once our database and tables are available, |7,
you can create a form by following the instructions below.

Steps:
1. From the Navigation Pane, choose the table.
l\f‘ A|
e B “f 1
Wiew i Filter
Views Clipboard = 5
All Access Objects® <
Search.. =
Tables 4
j Details
j Sales

Figure 3.1: Navigation Pane

2. Click the Form button in the Forms group after selecting the Create tab from the ribbon.

O
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3.

A new form has been created; notice how the ribbon’s options have changed and how

the Design tab is now active.
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Figure 3.2: Design Tab

Click the Home tab and then the view button displayed in the Views group to input or

edit records in the form. Go to the drop-down menu and choose Form View.
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Figure 3.3: Form View

Update the value, then press the Enter key to modify it. Open the form table using the
Navigation pane and look for any changes to see whether the value has changed.

'
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@ RECORD NAVIGATION BAR

A form’s record navigation bar is a crucial component. It facilitates the form’s navigation
and value modification. Let’s quickly comprehend how this bar functions.

Displays the Displays the next Enter a New Search for a
previous record record Record specific record
| Record: I4 1 of 1 g Search
Displays the first Displays current Displays the last
record record record
@ FORMATTING A FORM

Changing Themes and Fonts of a Form

Follow the given steps to change the theme of a form.
Steps:

1. In the Navigation pane, click the name of the form. Launch the Layout View and open
the form.

2. Click on the *!'button in the Themes group. We can choose the theme we want from
the drop-down list. By selecting the Colours and Fonts button found in the Themes
group, we can also alter the theme’s colours and font.

5 Students_info | [l Students info |__='| Students_info

"= Details

ROLL NO 1

2

FIRST_NAME trisha singh
CLASS [10

MARKS 78
FATHER_NAME |Ganesh singh

ADDRESS #10, chandigarh

Figure 3.4: Applying Themes and Fonts
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Inserting Date and Time to a Form Date and Trme ? %

Follow the given steps to insert Date/Time to the Form. [ Include Date

(®) 23 September 2022
Steps: (O 235ep-22

(0 23-09-2022

1. Inthe Layout view, open the form. Arcdetme  PIC

2. Select the Date and Time option in the Header/Footer | @1u4s:44 date and time

group ==
3. Choose the preferred date and time format from the | _
Date and Time dialogue box. 23 September 2022

11:45:44
4. Click on the OK button to insert date and time.
Cancel

Arranging the Order of the Fields in the Form
Click the Arrange tab in the MS Access ribbon to reorder the text fields of the form.

Table Rows & Calumns Merge / 5plit Move Pasition
Figure 3.5: Arrange Tab

To reorder the text fields in a form, use the set of options found under the Arrange tab.

Adding Background Image to a Form

Follow the given steps to add a
background image to a Form.

Steps:

1. Inthelayout view, open the
form.

2. Select the Background
Image option by clicking
the Format Tab.

3. Select Browse. The dialogue
window for inserting a
picture will display.

5 NI

<2, = Do You Know?

Anchoring is a cool feature which
gives your form a professional look.

Figure 3.6: Inserting Picture

Computer -8
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4. Click the open button after choosing the image you wish to use as a background image.
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Figure 3.7: Form Background Image

1 RN Lrieeh

@ SAVING A FORM

Follow the given steps to save a form.

Save As ? X
Steps:

1. Click on the Save Button in the | Form Mame:
Quick Access Toolbar to save a | Details_Form 1

form.

2. In the Save As dialogue box, type Ok Cancel
the name in the Form Name text
field and click on OK.

@ QUERY IN ACCESS 2016

In simple terms, a query is a simple question that you ask to find specific information from
the database. Similarly, in Access, when you build a query, you are defining specific search
conditions. You can use queries to view, change, summarise and analyse the specific data in
different ways.

Queries are made on tables and the results are displayed in the forms of a table,which are
composed of rows and columns and include the data that satisfy the criteria.In other words,
a query is like a question you ask from a database, and the database in reply returns the
required records you have requested.
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Query: Get me the records of Database: Here are the
all the patients suffering from records you need.
heart problem.

In Access, a query can be created in two different ways. (.
query AlCD Let Me Answer

1. Using Query Design Does a sudden question appear on your
2. Using Qu ery Wizard screen when you enter a website, sometimes?
You can have more control over a query with the design view. \'*
You can build a query from scratch with it. REMEMBER IT] @

A query gives the user a custom
Steps view of the data.
1. Ontheribbon, select the Create tab. Then, in the Queries group, click the Query Design

button.

2. 'The dialogue box for the show table will appear. Choose a table from the list of tables
for your query. Depending on our needs, we can choose a single table or a number of
tables.

Show Table ? o

Tables | Quieries Beth

datais
soles

[ oces
Figure 3.8: Show Tables
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3. Click the Add button after choosing a query table from the Show Table dialogue box.
You'll see the screen given below.

All Access Objects® ¢ | = tetsic LT baed |31 Oueert

S
Tabies " i Shepe Tk I
T desm 1ig TEbY fperes Baly
[T cind farat s
Cor ik st ol
Ty A
vl Sty
[i] ]
o
Taie
St
Tz L. L: E |_ L L
Crléria
ar
e
Ry Hum lack = R

Figure 3.9: Query Design Window

4. See how the Object Relationship Pane displays the fields from the selected tables.

TN cnkaity | T raien | S5 daenrd o

i Object Relationship Pane
-:\..1.|-_:::l:rsm

Ciah, At

Field Property

;]
0

O O o O O O

Query Design Grid

Hum Lack 1= y 4

Figure 3.10: Query Design Window

5. A query is made up of one or more table fields. Drag and drop the fields to the field
property to add them to the query in the Query Design Grid as shown below.

o
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Field: |ID cust first_name v
Table: | details details details
Sort:
Show 0 O 0 0 0 0
Criteria:
o
ne ]

Figure 3.11: Query Design Grid

6. When your query is ready, click the Run button in the Results group on the Design tab
to see the query’s results. The query’s outcome will be displayed in the output window,
as seen below.

gh
& Nishar B
5 frisea pingh
1t hrigh pingh

Mavigation Pane

BOANE W A A80 R LI r Ladsh

Figure 3.12: Query Result

@ CREATING QUERY WITH QUERY WIZARD

A small built-in application called Wizard asks users questions and then displays a result
based on their inputs.

Steps:
1. Select the “create” tab. In the queries group, click the Query wizard button.

OE N GiemalData  DatabaseTools  Help  Tablefields  Table Q' Tell mewhat you wantto do
b\ — - ) , . I . "
D K D K = D [ Form Wizard j @ :| 3 Report Wizard D 2 Madule
1 N T = e : ¢ J

— . Navigation ~ I;‘" Class Module
Application | Table Table SharePoint | Query Query | Form Form  Blank Report Repart Blank S| 1pelc Macro _ .
Parts ~ Design  Lists ~ Wizard Design Design Form More Forms ~ Design Report | Visual Basic
Templates Tables Cueries Forms Reports Macros & Code

Figure 3.13: Create Tab
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2. The New Query dialogue box appears. By default, the Simple Query Wizard option is
chosen. Click OK to continue.

Mew Query T -

\Simple Query Wizard

Crosstab Query Wizard

Find Duplicates Query Wizard
Find Unmatched Query Wizard

This wizard creates a select query
from the fields you pidk.

Cance

Figure 3.14: New Query

3. Asillustrated below, the wizard will now ask us to choose the query table and the fields
inside it that we want to include in the query.

Simple Query Wizard Simple Query Wizard
Which fields do you want in your query? | Which fields do you want in your guery?
You can choose from more than one table or query. You can choose from more than one table or query.
Tables/Queries Tables/Queries
Query: Queryi o Table: details V
Available Fields: Selected Fields: Available Fields: Selected Fields:
jin] =
Cust_Gity 0=
Field1
Figure 3.15: Selecting Fields Figure 3.16: Adding Fields

4. We will be asked to enter the query title in this final step. Additionally, we have the
choice of the following two possibilities.

< Open the query to view information.

< Modify the query design.

< Open the query to view the result of the query.

< Select the second option if you wish to modify the query.
5. Click the finish button after selecting the first choice.

o
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@ REPORTS IN ACCESS 2016

For viewing or printing, a report is a useful tool for organising and summarising data. A
report can be created exactly the same as we have created the form. The only modification
is that you now click on Report in the Reports group after choosing the Create Tab.

Let’s learn to create reports in Access.

Steps:

1. After selecting the Create tab on the ribbon, go to the Reports group and select the

Report button.

2. The Report Layout window displays a new report; notice how the ribbon’s options have
changed and how the four new tabs Design, Arrange, Format, and Page Setup have

been added to the ribbon.

0 Shuderey s | ] Siedans, nia'| T

Figure 3.17: Report Layout Window

@ SAVING A REPORT
Follow the given steps to save a Report.

Steps:
1. Click on the Save button in the

Quick Access toolbar to save a
report.

2. Type the desired form name in the
Save As dialogue box in the Report
Name text field and click on Ok.

1 Save As

1 Report Mame:
| Details |

QK

o

Cancel




= Kids’ 1Q

Fifty records have been added to a database that Sanisha established of her classmates.
She must display the statistics for the kids who received less than a 35% grade, per the
teacher’s request. Give her some advice on how to apply this standard.

’ Let’s Recall

A form is a device for gathering data in a sequential style.

o The presence of an operational database and a table is one of the requirements for
building a form in Access.

e A query is a simple question that you ask to find specific information from the
database.

o A small built-in application called Wizard asks users questions and then displays a
result based on their inputs.

o Areportis a useful tool for organising and summarising data which can be created
exactly the same as we have created the form.

~
A. Fill in the blanks
1. A form is a device for gathering dataina ... style.
2. The ..o is related to the table.
3. The presence ofan .................... database and a table is one of the requirements for
building a form in Access.
4. Choose the table from .................... pane.
5. facilitates the form’s navigation and value modifications

B. Write ‘T’ for True statements and ‘F’ for False statements.

1. The Arrange tab reorders the text fields of the form.

U0

2. Save button is present on the File tab.

3. A query is a simple question that you ask to find specific information
from a database.

9
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4. Queries are made on documents.

5. A report is a useful tool for organising and summarising data. ()

C. Answer the following questions.

1. Whatis a form?

Amazon has a huge database of employees and clients. The company wants to maintain
the privacy of each employee and client. They have given the instructions to computer
operators to update each record, one at a time.

Which database object should it use to perform this task?

Team Work

Conduct a group discussion on the following topic:

Creating Query using The Query Wizard v/s Creating Query using The Query Design.

o




CLOUD COMPUTING

At the end of this chapter, the students will be able to:
+ Learn the pros and cons of Cloud Computing.
+ Know about different types of clouds.

+ Understand different types of services a cloud can offer.

Observe the following picture and write five things that come to your mind.

TR  Ask students how these clouds are somehow useful to us, how they help us. Also introduce them
* B PPY  with the term ‘ Cloud Computing’.

Computer -8 9




L Hello Friends! Lets learn about
Cloud Computing.

Cloud computing is a service that requires a subscription and includes a number of services.
These services are used by individuals and organisations. Because all the processes take
place in the internet world, it is known as cloud computing.

Today, cloud computing is attracting a lot of interest from consumers, including everyone
from individuals at home to the government. One approach to understanding cloud
computing is to think about how we use our email account.We launch a web browser and
sign into our email account to view our email when we need to. Our email accounts aren’t
kept in the computer’s memory, but we can access them B ? -
from anyplace with an internet connection. Our emails ek Do You Know?
are kept in a server computer that is physically situated | By 2023, researchers predict that more
£ . . .1 | than 40 zettabytes of data will be stored
ar away. Our email account can be accessed via email
. o on the cloud.

server through internet connectivity.

The functioning of an email service is comparable to cloud computing. If we use a cloud
service, we can access a variety of user-available services like storage, processing, and
security services in addition to accessing our email.

o » ADVANTAGES OF USING CLOUD SERVICES

You can become an expert in machine learning if you comprehend other concepts that are
related to it. The various fields that have contributed to machine learning are briefly listed
below.

Freedom of Access

The drawback of the conventional computer system is that we must physically be where our
data storage device is in order to access it.Through the internet, we may access data using
cloud services from anywhere in the world.

Helpful for Businesses

Small businesses can benefit from cloud services. However, they provide a significant
contribution to small businesses by providing them with storage and processing capabilities,

o
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which were previously only accessible to large organisations because of the high cost of
infrastructure construction.

Flexible Services

Sometimes, a business or a person may need more or less space depending on their storage
space needs. We can also quickly sign up for or discontinue using a cloud service.

Reduction in Cost

If someone wants to launch a Television == Topiots

new business, they will need /7
to invest a lot of money in new
computers, internet access ~ ~, SMS
devices, additional storage - )
g =

devices, security measures, and Internet_

software licences.This would £ . A

Mobile

undoubtedly take a large amount Q.!.!.) A\

of money. By using cloud sl Cloud

services that can meet all of our computin g <E)
needs for storage, security, and L~ '

app accessibility, we can reduce _ N ~

this expense. The setup cost will . ' g Deskiop
be significantly reduced by using —~ E

cloud services. Server

Cloud Storage k
The majority of cloud providers Selsliel

offer storage options. Users love Figure 4.1: Cloud Computing

these storage services extremely. Google Drive, Dropbox, One Drive, and other well-
known services are very popular. As a result, it is crucial for us to comprehend the security

procedures that a cloud service provider has in place and to take our own steps to protect
our data.

TYPES OF CLOUD SERVICES

Different types of cloud services are available depending on the needs of the users.

Public Cloud

Anyone with an internet connection and access to the cloud space can use the public cloud.
All its users have access to the public cloud. It is accessible to everyone, but the data and
applications used by one subscriber are hidden from all the other subscribers.

o

Computer -8




Private Cloud

A private cloud is created specifically for a given organisation, and only that organisation is
permitted to use or access it. Access to data and applications is strictly controlled in private
clouds. An example of this may be a school’s canteen, which is solely open to its own faculty,
students, and staff.

Community Cloud

@ Let Me Answer

similar cloud needs. This kind of solution aids businesses in | Discuss about icloud service
provided on Apple phones.

A community cloud is shared by two or more businesses with

cutting costs associated with cloud services.

Hybrid Cloud

In core, a hybrid cloud is the merging of at least two clouds, where the clouds are a mix of
community, private, and public clouds.

PUBLIC PRIVATE HYBRID COMMUNITY

v v y v

Provisioned

for open use

for the public

by a particular
organisation who
also hosts the
service.

Used for a single
organization; can
be internally or

The composition of
two or more clouds
(private, community

Shared by several
organisations;
typically externally

externally hosted. or public) that
remain unique

entities.

hosted, but also
can be internally
hosted by any
organisation.

Figure 4.2: Cloud Computing

TYPES OF SERVICES PROVIDED IN CLOUD

Software as a Service

A SaaS cloud service gives subscribers access to different applications (apps). SaaS frees us
from downloading and storing an app in our phone, this means you do not need to install
the required app on your devices. SaaS makes it easier to have the same software on all the
devices at once by accessing it on the cloud.
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Platform as a Service

A Paa$ system goes a level above the Software as a Service setup. A PaaS provider gives
subscribers access to the components required to develop and operate applications over the
internet.

Infrastructure as a Service

In an laa$S agreement, the subscriber completely outsources the storage and resources, such
as hardware and software, that they need.

All this simply means that we can choose a specific cloud service based on our requirement.

% CLOUD SECURITY
We all recognise the need of protecting

Access Video
our data from unauthorised users. By Control o e Surveilance

incorporating system security in the form of

a user ID, password, or pin, we may protect _

the data on our computer. However, if we wmanagement
Software

Secured
Web

are using the internet to store our data on a

sy

F s
N i B
",'-=|;: iy

cloud service, it may also free up more space @ :
for other users to access our data.

Fire Alarm
Integrator

Alarm
Management

However, we will have to willingly lose direct

control of our data in order to benefit from o
the cloud. On the contrary, keep in mind that :

Elevator ID Badging
most cloud service providers have a great Control

Mass

deal of knowledge on how to keep our data Notification

safe. In order to secure their computers and Figure 4.3: Cloud Security

networks, service providers have access to more tools and knowledge than the average user.

The following considerations should be made by a user before choosing which cloud services
to use.

<  Whatkind of encryption does the provider use?

< What methods of protection do they have in place for the actual hardware that our data
will be stored on?

< Do they have duplicates of our data on hand?

o
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< Do they have firewalls set up?

< What safeguards are in place to prevent a user’s information from being shared with
other users if they have a community cloud?

@ DISADVANTAGE OF CLOUD COMPUTING

< We have little to no understanding of where our data is stored, and we have limited
control over who has access to our information.

< Our data is frequently accessed by hackers without our permission.

@ SOME POPULAR CLOUD SERVICES

Dropbox

One of the best cloud services for sharing files is Dropbox. It offers e
its customers SaaS-based services. Many people take advantage of REMEMBER RIT! 34

its limited free storage options, but it also provides paid services | 1.2 billions files are saved on
Dropbox every day.

to both individuals and organisations under various plans.

Google GSuite

The most widely used email application in the Google Play Store
is Gmail, a free online email service. Google Calendar, Google (- FprgTpy T

Drive, Google +, Hangouts, Docs, Sheets, Forms, Slides, Sites, | Do you have a gmail account?

Keep, and Jamboard are all part of Gmail’s email service. Italso | G008le drive.

provides cloud-based storage services to the users.

Adobe Creative Cloud

Creative professions like artists, filmmakers, designers, and other creative professionals
can access cloud-based services from Adobe Creative Cloud. InDesign, XD, Premiere Pro,
Dreamweaver, etc. are a few of the most well-known apps.

- = Kids’ 1Q

What kind of cloud service should your school or institution choose, and why, it is

required to do so?
Computer -8
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@ Let’s Recall

Cloud computing is a service that requires a subscription and includes a number
of services.

If we use a cloud service, we can access a variety of user-available services like
storage, processing, and security services in addition to accessing our email.

One of the best cloud services for sharing files is Dropbox.

Creative professions like artists, filmmakers, designers, and other creative
professionals can access cloud-based services from Adobe Creative Cloud.

A private cloud is created specifically for a given organisation, and only that
organisation is permitted to use or access it.

~
A. Fill in the blanks.
1. Cloud computing is a service that requiresa ...................
2. The functioning of an ................... service is comparable to cloud computing.
3. businesses can benefit from cloud services.
4. ‘'The majority of cloud providers offer .................... options.
5. A is created specifically for a given organisation, and only that

organisation is permitted to use or access it.

B. Write ‘T’ for True statements and ‘F’ for False statements.

1. One of the best cloud services for sharing files is Dropbox. ()
2. The most widely used email application in the Google Play Store is Yahoo. [ )
3. A hybrid cloud is the merging of at least two clouds, where the clouds are

a mix of community, private, and public clouds. ()
4.  Access to data and applications is uncontrolled in private clouds. ()
5. A community cloud is shared by two or more businesses with similar

cloud needs. ()

Computer -8 @




C. Answer the following questions.

1. What is cloud computing?

Samaira prefers to use a cloud-based service that will provide her access to various
Office-based programmes rather than installing Microsoft Office on her laptop.

Name the service you think Samaira should use.

Team Work

Together with your pals, make a video outlining the benefits and drawbacks of
cloud computing. Use your teacher’s assistance to show the video to each of your
classmates.

O
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At the end of this chapter, the students will be able to:
+ Learn about Arduino.

+ Know various parts of the Arduino board.
+ Write code in Arduino IDE.

3, B ——
. R @ e

4 }(‘ ...................................................................
5 .
(’"ﬁ ...................................................................

Guide students that as our sense organs are capable of performing multiple tasks, a microcontroller
is a small computer chip mounted on a single integrated circuit that is capable of performing
multiple operations like input, processing and output.
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Hello Friends! Lets Know
about Arduino

@ ARDUINO

Arduino is a tiny computer chip installed on a pegs
single integrated circuit, it is a reasonably priced B7 i/ Do You Know?
microcontroller. It has a processor, memory, and | Arduino was initially intended to serve as a

programmable input/output peripherals. It is teaching tool that would introduce students
to the world of electronics.

capable of performing multiple operations like input,
processing and output.

The majority of the computers we are acquainted with accept @Let Me Answer
human input via a keyboard and mouse. The many sensors that are | How can a robot sense its
attached to an Arduino allow it to sense light, sound, vibrations, | ¢vironment?
temperature, and other things as well as receive input from the

user. These measurements can subsequently be transformed into digital signals by the
microcontroller.

Humans use their senses to perceive their surroundings. Similar to this, if we combine
several sensors with a microcontroller, these sensors can scan the area around us and relay
inputs to the memory for processing. The result can then be seen on the screen.

Figure 5.1: Arduino and its Sensors

'
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@ PARTS OF AN ARDUINO

1./ Built-In LED

Whether your Arduino is delivering or receiving data is indicated by the LEDs labelled TX
and RX.

2., On Indicator LED

When the LED is turned on, this shows that it is receiving electricity.
4, 1. 3.

TX/RX Pins build-in-LEDs Input and Output pins

Reset button

USB port

= w0 Tx]
H T
2.
DIGITAL (PWM= =~ £ & On indicator
L - ..‘.bi“I“..‘l“‘l‘. LED

{UNO;

[TITEITEL IR ]

TX . _
Rx @ Arduino

Voltage
regulator

Power
port

Power and ground pins Analog pins

6. 7.
Figure 5.2: Parts of an Ardunio Board

3.] Digital I/O Pins

The holes on this side of the board are called the digital input/ output pins. They are either
used to sense the outside world (input) or control lights, sounds or motors. (output)

&
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4. TX/RX Pins

Special pins with the labels TX and RX are PIN 1 and Pin 13. You should always leave these
pins empty. Anything wired into Pin 0 prevents your software from loading any changes

you make.

5. ATmega328P, Black Chip

An ATmega328P is the black chip in the centre of the circuit board. This is the brain of the
Arduino. It interprets the programming code that you submit to your Arduino as well as the

inputs and outputs.

6.] Power and Ground Pins

Here are the power-related pins. These pins can be used to connect the Arduino to
the breadboard circuit's power supply. These pins capture a range of values of sensor
readings.

7. Analog Pins

Instead of providing a simple on/off signal, these pins take sensor measurements throughout
a range of values.

X CONNECTING YOUR COMPUTER TO ARDUINO BOARD

Following steps indicate how we can connect the Arduino to the computer.

Selecting Right Components

An Arduino, a computer, and a USB A-B cable are required.

Plug-in USB Cable

Start by inserting the USB cable into a computer’s USB port as demonstrated below. Connect
the USB cord to the Arduinos USB port.

Figure 5.4: Arduino USB Port




See the Arduinos top view of the USB port with the USB A-B cable

Figure 5.5: USB Port Top View

@ ARDUINO IDE

With all the features one would require, the Arduino team has created an IDE for use with
their devices.

It includes a tool called a code editor that can be used to write any kind of code.With the aid
of a message box that displays code faults and a console that provides further information
about the nature of these mistakes, the code can be tested in the IDE and utilised to address
any emergent problems. It has buttons for checking the code, saving it, uploading it to
Arduino, and other functions.

Menu -

® DR theier Toos Belp

Standard Toolbar

skeich_suglSa ine

1 il setugd )

Code Editor Window

Figure 5.6: Arduino IDE
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Rememser 11! &6

In 2014, more than 240 user groups, Makerspaces, hackerspaces, fab labs, schools, studios and educators
throughout Europe, North and South America, Asia, Africa and Australia came together to celebrate the
inaugural Arduino Day.

@ WRITING YOUR FIRST PROGRAM

Now let’s use the Arduino IDE to write some code. Code for Arduino can be written in a
variety of languages, including Java, C++, and Python. Since we know Python, we will write

our code in Python.
To connect Python and Arduino, follow the instructions.

Steps:
1. Open Arduino IDE.

2. Click on File> Examples>Firmata> StandardFirmata

& sietch_sugSa | Arduins D 20,0-rc82 - [m] b4
E:'- Skeich Toch Haelp
= i st - m
Cprns il 1.8 E
Dpen Bacens " 02 Diigptad v ]
Tiptchbooi B Sanaing ¥
(- bW JiLonsol "
¥l iria o Lersin
Cyog Lo trlm it § o7 Deapiay
L BB 5trings
Preferendes.. Cirle]
s H ’
Bdvansed L] 10 Searteris Basckit ¥
= Argaingdy
Cus
Ciote TEn0
——— EERROM v
AlllngotaFrmain
iR "
draioghrmata
Softmarefarayl .
Eeheltnng

DlaSuadandrirmats

Lerafrmats
Eshirmet " L mnledes ogForats
I Finmaia I k SomplelngitalFrmats
Krybama L] i Lrpadandtmats I |
ipaisCryrnl v Susdedferanill |
I P Sesrento

Figure 5.7: Selecting StandardFirmata Library

3. To load the Firmata support files to the Arduino Board, click the tick button now.

4. 'The pyFirmata library needs to be downloaded to Python . This makes it easier for us
to write code in python for Arduino.
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5. Enter “Command prompt” in the search box, then select “Run as administrator.”

AR

Best match

- Command Prompt

Seitings
Command Prompt

= Reptace Command Prompt with
Windows PowersShed] in the Win + X

Search the web

2 emd

Figure 5.8: Opening Command Prompt

6. In the Command prompt window, type the command pip install pyfirmata and press
the Enter Key. The downloading process will begin after this.

o+ Command Prompt

Figure 5.9: Installing Pyfirmata
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7.  Now open the Python IDE and write the code given below.

| File Edit Sketch Tocls Help

Claseic_Blink_LED §
const int LED = 13: o
void setup()

l
pinMode { LED, QUTTUT) 2
)

wiold loop([)

{
digitalWrite (LED,HIGH] 2
delay(1000)
digicalWrice (LED,LOW} 7
delay (1000)

Figure 5.10: LED Code

8. After pressing F5 to run the code, you should observe the LED on pin 13 begin to
blink.

Search about a microcontroller chip. Talk about it in the class. J

! Let’s Recall

Arduino is a tiny computer chip installed on a single integrated circuit.

o Itis capable of performing multiple operations like input, processing and output.

o The many sensors that are attached to an Arduino allow it to sense light, sound,
vibrations, temperature, and other things as well as receive input from the user.

o  Microtellers can then convert these measurements into digital signals.

« Different languages can be used for writing code for Arduino like Java, C, C++, and
Python.

@
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pskill Your Intellig

A. Fill in the blanks.

B.

1. Arduino is a tiny computer chip installed on a single ....................

2. 'The many sensors that are attached to an Arduino allow it to sense and receive
.................... from the user.

3. If we combine several sensors with a .................. , these sensors can scan the area
around us.

4. Microtellers can convert measurements into ................. signals.

5. Arduino includes a tool called a .................... that can be used to write any kind of
code.

Write ‘T’ for True statements and ‘F’ for False statements.
1. 'The black chip in the middle of the board is an ATmega328P.

2. Pyfirmata is required to establish communication between Python
and Arduino.

4. You cannot write code in the Arduino IDE.

3. Analog Pins take sensor measurements throughout a range of values. ()
5.  Arduino IDE has an in-built code editor. ()

Answer the following questions.

1. What is a microcontroller?




5. Differentiate between an Arduino and a normal computer.

Label the Arduino board shown below.
4. 1. 3.

Reset button

USB port

DIGITAL {(PWM= =4
L - AERe Rt R R,
o .

UNO

T Il T [0 .

rx Em Arduino

Voltage
regulator

Pg;v: ' " ANALOG IN .
£ 0 - ¥ : . o o4 T L

=

Team Work

Team up with your partner and create a program in python that will blink LED 8
and 9.

Computer -8
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ol gS'LOOPING STATEMENTS IN PYTHON

At the end of this chapter, the students will be able to:
+ Comprehend Looping statements in Python.

’

Traverse elements using loops.

+

Know the working of the range function.

*

Know the operations of for and while loops.

Play the game.
Start here! I have 25 I have 38 I have 18
Ineed5x5 I need 26 + 12 I need 6 x 3 I need 44 + 11
I have 55 I have 28 I have 65 I have 36
Ineed 7 x 4 I need 41 + 24 I need 9 x 4 I need 32 + 12

Guide students about the loop game. Introduce them with the loop statements in Python, what if
something has to be printed 100 times. You need to type 100 times which seems time-consuming.
So, this is where the loops play a very important role.

o




b Hello Friends! Lets learn
about the looping statement
in Python.

The idea of a loop enables us to execute programme instructions repeatedly without
having to repeatedly write the same ones.The successful execution of loop depends on the
condition. As long as the condition returns True, the statements continue to run.The loop
ends automatically when the condition returns False.

For Example, Mother gives you a bowl of rice. You won't eat it up at once. You start with
the first spoon, then second and so on. In this manner, you finish your rice after several
tablespoons of eating. (let’s say eight)

Let’s examine the programming-based loop example.

Let the control variable be A. In this example, we have taken the initial value of A as 0.
When you eat the first spoon, the value of A becomes 1, after the second spoon, its value
becomes A = A + 1ie, 1+ 1 =2 and so on. The value increases every time the process
repeats. After being increased, the control variable C will be evaluated to the maximum
number of repetitions, which is 8 rounds.

‘ Start

l

Take start eating as A

Are the number
of time you eat
greater than or
equal to
8 (A>=8)?

Yes l

‘ Stop

Y
A=A+1
(Take more rounds)

No

;‘
r‘

Computer -8




It will keep going till the value of A equals 8. This indicates that the loop will repeat itself
eight times before coming to an end.

o
<2 = Do You Know?

The use of loops in programming has the benefit of reducing both the number of instructions and the amount
of memory required.

Python uses loops to iterate through sequence elements. Two different types of loops are
available in Python for use in looping operations.

< Forloop
< While loop

4 FOR LOOP
The for loop is used to repeatedly iterate over a sequence’s values. These values can be either
string, list or tuple values.

The control variable determines whether each value in the sequence has been traversed or
not with each iteration.Traversal is the process of accessing elements in a sequence one at
a time.The for loop’s body is no longer performed once all the values in the sequence have
been traversed; instead, control is passed to the statements that come next.The for loop
statement is used when you know the number of iterations beforehand.

Let me answer: How would you define a loop?

The ‘for loop’ is also called a counting loop.

Program: Printing the characters of a string.

For letter in APPLES’”:
Print (‘Current Letter’ : letter)

File Edit Shell Debug Options Window Help
Python 3.10.7 (tags/v3.10.7:6cc€ébl3, Sep 5 2022, 14:08:36) [MSC w.1933 64 bhit »
(AMDEe4) ] on win32
Type "help™, "copyvright™, "credits™ or "license ()™ for more information.

REESTART: D:“\Users‘\Admin\Desktop\pyvthon\program 4.py ===========
Current Letter :
Current Letter @
Current Letter :
Current Letter :
Current Letter :
Current Letter @

e [¥]

Ln: 11 Cok D

L e I S = B T =

Output
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Program: Printing the items of a list.
SDGS = (" Women Empowerment’, ‘Girl's Education, ‘Gender Equality’)
for goal in SDGs:
print (‘Current goal:} goal)

A |DLE Shell 3.10.7 - g X

File Edit Shell Debug Options Window Help
Python 3.10.7 (tags/v3.1l0.7:6ccebl3, S=sp 5 2022, 14:08:36) [M5C w.1933
64 bit (AMDE4)] on win3z2
Type "help™, "copvright", "credits"™ or "license ()™ for more information

EESTART: D:\Users\Admin‘\Desktop\python\program S.py =—==

Current goal : Women Empowerment
Current goal : Girls Education
Current goal : Gender Equality

Ln: & Colk0

Output

@ LOOP CONTROL STATEMENTS

There are three loop control statements in Python. These are used to alter how the loop
typically operates.

Break Statements

The break statement ends the loop statement and shifts control to the statement that comes
right after the loop.
Program: Using break statement

SDGS = ( Women Empowerment’, ‘Girl’s Education, ‘Gender Equality’)

for goal in SDGs:

If goal =="Women Empowerment’

print (goal)

break

This will print only “‘Women Empowerment” and stop the execution of the loop although
more items are present in the list.

Computer -8




 |DLE Shell 3.10.7 — O x

File Edit Shell Debug Options Window Help
Python 3.10.7 (tags/v3.l10.7:6ccébl3, Sep & 2022, 14:08:36) [MS5C w.l193

3 64 bit (AMDe4)] on win3Z2
Type "help™, "copyright"™, "credits™ or "license ()" for more informatio

n.

RESTLART: D:\Uszers\bdmin\Dezktop\python\program &.py =——

Women Empowerment

Lm: @ Cok0

Output

Continue Statement

This command causes the loop to skip the remaining portions of its body and to retest its
condition right away before updating the loop variable.

Program: Using continue statement to not print "Women Empowerment’
SDGS = (" Women Empowerment’, ‘Girl's Education, ‘Gender Equality’)
for goal in SDGs:
If goal =="Women Empowerment’
continue
print (goal)

This will print the other items of the list except ‘Women Empowerment’

& |DLE Shell 3.10.7 — | ot

File Edit Shell Debug Options Window Help
Python 3.10.7 (tags/v3.10.7:6ccebl3, Sep 5 2022, 14:08:36) [M5C v.l1533

64 bit (AMDE4)] on win32
Type "help", "copyright"™, "credits"™ or "license ()" for more information.

RESTART: D:“Users\Admin'\Desktop'\python\program 7.py

Women Empowerment
Girl's Education
Gender Egquality

Lrn: & Cok0

Output
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Pass statements

Pass statements are used to create empty loops.

A emptyloop.py - DAUsers\Admin.,  — O > # |DLE Shell 3,10.7 — O >
File Edit Format Run Options Window Help File Edit Shell Debug Options Window Help

for letter in "Reduced Wostage Goals™: . ™
p:i:fi":as: Letter:", letter) RESTART: D:‘\Users'ad

mintDesktop\pythont\emptyloop.py ===

Last Letter: =
B W
Lmn:1 Cok0 Ln: 2 Col: 72

Empty loop

@ INFINITE LOOP

If a condition never evaluates to FALSE, a loop becomes infinite. It occurs because the loop
either lacks a terminating condition or has a requirement that can never be satisfied. As a
result, a never-ending cycle is created. It is known as an infinite loop.

Program: Write a program to display an endless loop.
var=1
While var == 1:
num = int(input(“Enter a number :”))

print (“You entered: “, num)

# *IDLE Shell 3.10.7% — O x

File Edit Shell Debug Opticns Window Help

Python 3.10.7 (tags/v3.l0.7:6ccEbl3, Sep 5 2022, 14:08:36) [M5C w.1933 €4 bi
t (AMDE4)] on win32
Type "help”, "copyright®™, "credits™ or "license ()" for more information.

============== RESTART: D:\Users\Admin\Desktop\python\programd.py ===========

Enter a number :15
You entered: 15
Enter a numker :20
You entered: 20
Enter a numker :30
You entered: 30
Enter a number :&0
You entered: &0
Enter a number :100
You entered: 100
Enter a number :

@ WHILE LOOP

In the while loop, if the specified condition is true, a series of statements will be carried out
. Prior to starting the body of the loop, the condition is tested. One statement or a group of

©

Ln:15 Cel 16

Output
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statements could be found in the loop body. The statement that comes straight after the loop
receives control when the condition is changed to false. It's referred to as a conditional loop.

Syntax:

REMEMBER IT!

Pythongroupsstatementsusingidentification
statement(s) as a grouping strategy.

while expression:

The body of the loop is skipped and the statement that comes after it is performed if the
condition is first found to be false.
Program: Write a program to print all the numbers up to the number entered by the user.
n = int(input (‘Enter a number:’))
while (n > 0):
print (n)
n=n-1

The user is prompted to input a number in this section. The condition is checked first,
then the number is entered. Since 4 was entered , the condition is true, and so 4 is printed
according to the first statement inside the loop body.

The value of n is then decreased by 1, making it 3 (i.e. 4-1). The operation is repeated after
returning to the loop’s first statement to check the condition. As a result, the loop runs four
times until the value of n equals 0, at which point the condition will be considered false.
After the while loop, control will move to the statement.

Write a program to print the odd numbers between 1 and 30.

= Kids’ 1Q J

! Let’s Recall

The idea of aloop enables us to execute programme instructions repeatedly without
having to repeatedly write the same ones.

o The ‘for loop’ is also called a counting loop.

o The break statement ends the loop statement and shifts control to the statement
that comes right after the loop.

o In the while loop, if the specified condition is true, a series of statements will be
carried out .

o Ifacondition never evaluates to FALSE, a loop becomes infinite.

©
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pskill Your Intellig

A. Fill in the blanks.

1. The successful execution of the loop depends on the .......................

2. Thereare ... loop control statements in Python.

3. is the process of accessing elements in a sequence one at a time.

4. If a condition never evaluates to FALSE, a loop becomes .........................

5. command causes the loop to skip the remaining portions of its body

and to retest its condition right away before updating the loop variable.

B. Answer in one word.

1. Aloop that tests the condition before executing the loop body.

----------------------------------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------------------------------

5. This statement ends the loop statement and shifts control to the statement that
comes right after the loop.

C. Answer the following questions.

1. What are loops? Give real life examples.

Computer -8




2. What is an infinite loop?

{}\ Critical Thinking

£
Is an infinite loop useful? Think and write.

Team Work

Team up with your partner and write a program to find if the given number entered
by the user is even or odd.

o




ROBOTICS

At the end of this chapter, the students will be able to:
+ Know about Robotics.

+ Learn the composition of Robots.

+ Recognise the characteristics of a Robot.

+ Understand the types of Robots.

+ Comprehend the uses of Robots.

Think about the following questions and write the answers.

Q1. What is your plan for the coming weekend?

Apprise students that to answer the above question, they had to think a bit. In the same way,
when a machine thinks and decides independently it makes it artificially intelligent.

©
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e ¥ Hello Friends! You all know about
Artificial Intelligence. Lets learn
about one of the latest technologies
of Al i.e. Robotics.

'ul_ . =

@ ROBOTICS

The study of building effective and intelligent robots is the focus =
of the artificial intelligence field of robotics. e ®
Robots are artificial agents that behave in the real world. They A R

can carry out the tasks that a person gives them. Robots are
equipped with sensors that can recognise and pick up on
physical information from the outside world, such as heat,
light, temperature, pressure, sound, bumps, and movement.
To demonstrate intelligence, they have several sensors, a large
amount of memory, and powerful Processor cores. Additionally,
they have the capacity to grow from their mistakes and mould
themselves to the new surroundings. Electrical engineering,
mechanical . engineering, .and ﬂ, Let Me Answer
computer science are combined v vou cver seon o Robot? .
in robotics to design, build, and J ’ Figure 7.1: A Robot

use robots.

@ COMPOSITION OF ROBOTS

Robotics uses computer science, mechanical engineering, and electrical engineering to

build, develop, and use robots.

» Robots’ mechanical designs develop shapes or their forms to do a specific task.

< Electrical components power and regulate the machinery of robots.

“  Robots operate under the control of some sort o
of computer software that dictates what, when, §°5 = Do You Know?
and how they perform things.

. The term ‘robot’ comes from the Czech
Robots are developed with: word ‘Robota, that means ‘Drudgery’ or

< Actuator used in Robots convert energy into | ‘hard work® and ‘forced lab

movement.

.0

.0

.0
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< Electric motors are required for rotational movement.
< Batteries, solar power, hydraulic or pneumatic power sources.
< Muscle wires contract by 5 % when electric current is passed through them.

<  Sensors provide knowledge of real time information on the task environment.

Figure 7.2: Actuator Figure 7.3: Pneumatic Air Muscles Figure 7.4: Muscle Wires
"

REMEMBER IT! {84
AL

George Devol developéd the first digitally
Robots resemble humans in terms of their physical | operated Robot.

@ FEATURES OF A ROBOT

composition. They are held together by a structure, and they can move due to mechanical

components. A robot is capable of doing actions and movement.

< A robot absorbs information about its surroundings and makes use of that data to
carry out tasks as directed.

< It functions according to the programs installed in it and the programs can be changed
accordingly.

< Robots have sensors which enable them to see even in dark as well as detect the small

movements which a normal person is not able to do.

@ TYPES OF ROBOTS

Aerospace:

This is a broad category. It includes all sorts of flying robots the
SmartBird robotic seagull and the Raven surveillance drone,
for example—but also robots that can operate in space, such as
Mars rovers and NASA's Robonaut, the humanoid that flew to the Figure 7.5: SmartBird
International Space Station and is now back on Earth.

Figure 7.6: Raven
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Consumer Robots

These robots are available for purchase and are kept as toys. They also carry out other jobs
and errands for people. Aibo the robotic dog and Roomba the vacuum machine are two
examples.

Figure 7.7: Aibo

Disaster Response Tools

Robots used in disaster response do hazardous or
dangerous duties, such as looking for survivors after
a tragedy. Consider the Packbot, a mobile robot used
for hazardous material disposal and other risky duties.
It can drive through mud, climb stairs, and function
in all weather.

Industrial Robots

Industrial: The traditional industrial robot consists
of a manipulator arm designed to perform repetitive
tasks. An example is the Unimate, the grandfather of
all factory robots. This category includes also systems
like Amazons warehouse robots and collaborative
factory robots that can operate alongside human
workers.

Medical Robots

Systems like the da Vinci surgical robot, bionic
prosthesis, and robotic exoskeletons are examples of
medical and health-care robots.

o

Figure 7.10: Unimate

LN

R

Figure 7.11: da Vinci



% APPLICATIONS OF ROBOTICS

< Conservation: fighting forest fires.

< Manufacturing: working in factories, finding and carrying items in warehouses.
< Companionship: providing company to elderly individuals.

< Healthcare: assisting in surgical procedures.

< Delivery: completing food delivery and last-mile fulfilment.

< Household: vacuuming and mowing the grass.

< Rescue: undertaking search-and-rescue missions after natural disasters.

< Military Operations: detecting landmines in war zones.

- = Kids’ 1Q

Do you think Robots can replace Humans? J

! Let’s Recall

Robots are artificial agents that behave in the real world.

« Robotics is a domain in artificial intelligence which deals with the study of creating
intelligent and efficient robots.

» Robots resemble humans in terms of their physical composition.

o Robots are developed with batteries, Actuator, Muscle wires and sensors.

« Robots used in disaster response do hazardous or dangerous duties, such as looking
for survivors after a tragedy.

A. Fill in the blanks.
1. The study of building effective and intelligent robots is the focus of the ....................

field of robotics.

20 i, is an example of Medical robots.

3. are installed in the body of the robots to work like the five senses of a
human being.

4. Robots used in disaster response do .................... o) G duties.

5. is a domain of artificial intelligence that deals with the study of creating

intelligent and efficient robots.
B. Write ‘T’ for True statements and ‘F’ for False statements.
1. Robots cannot perform the tasks given by a human. ()
2. Aibo is a consumer robot. ()

@




3. Raven is an example of Disaster response robots. ()

4. Robots look like human beings. ()

5. A robot does not have the ability to sense his environment. ()
C. Answer the following questions.

1. Whatis a Robot?

Team up with your partner. Make a working Robot
using cardboard, thermocol or plastic bottle.

?




CYBER ETHICS

At the end of this chapter, the students will be able to:

+ Comprehend the concept of cyber security and ethics.

+ Recognise the several kinds of risks related to the internet.
+ Know about piracy and its types.

Observe the following picture and continue the conversation.

I'm sharing the latest news

What are you doing? .
about this person.

Are you sure
about this?

Example:

Remember, if you are
not sure. Please don’t
share.

Why not? Everybody is It is wrong to share something you
sharing it. Its viral news are not sure about. Please check of

sebenarnya.my to make sure the news
is right before yo share it.

kL

Guide students that everything they see on the internet is not true, you have to be very careful
while sharing the video with others.

Computer -8




b Hello Friends! Let us learn some
Cyber Ethics and ways to protect
ourselves, online.

When computers were first used, there weren't any guidelines or requirements on how to
use them. This led to various issues. But when their use spread in every aspect of our lives,
it became essential to establish some guidelines. At the national and international levels,
many of these regulations have been codified as laws.

The ethical use of computing resources is ensured by computer ethics. It outlines techniques
for avoiding breaking trademark and copyright laws. Furthermore, it addresses the
unauthorised dissemination of digital content.We must follow all the standards which have
been set for the appropriate use of the internet. It should not be used for wrong and illegal
purposes.

- » AVAILABLE RISKS ON THE INTERNET

We must educate ourselves on the risks associated with using the internet as responsible
users.

Loss of confidentiality of Information

Hackers are those who take advantage of a computer network or system’s flaws. They are
able to breach a computer’s poor security. Hackers take advantage of computer systems to
steal important data. They steal this material to strike revenge on others, gain fame, or for
financial gain. Hackers have cost organisations all over the world significant financial losses.

Fake information

It is quite challenging to verify the accuracy of the information because there is so much of it
available online. On social networking platforms, many internet users create fake accounts.
They think they can disseminate rumours in this way and get away with it. Rumours have
frequently ignited riots and hatred in the past. These rumours

ATV 8 . . . P @Let Me Answer
are disseminated via various social media apps. Make sure to

. . . . ] Have you ever come across any

check the information from reliable online sources or question | fke information?
individuals you trust before you believe any kind of information.

D
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Computer Virus

Many professional organisations use the internet to do their business online in the twenty-
first century. Companies and governmental organisations both save their important
information online. In order to disrupt this knowledge, individuals who want to steal or
destroy it construct alethal virus. One of the most popular methods used by these individuals
to propagate the infection is the internet.

@ CYBER CRIME

Cyber Crime is any crime that is committed using the computer and the internet where the
computer may be the target, tool, both. They involve criminal activities such as theft, fraud,
forgery and defamation. Cyber crimes are addressed by the Information Technology Act,
2000. Cyber policies take care of cyber crimes.

Cyber Stalking

Stalking is the recurrent practice of unwanted monitoring
or harassment with the intent to manipulate or influence
the victim. Online and offline stalking both are against the

law. ol
& Let Me Answer

What can be the ill-effects of
cyberbullying?

Cyberbullying

The act of harassing a person through electronic
media is known as cyberbullying. In this case, the
attacker uses intimidating messages to attempt to
corner the victim.

Identity Theft

It is a type of cybercrime when the culprit creates a false
identity in order to obtain financial benefits like credit
cards and loans, among other things. They borrow
money from a financial institution, fail to repay it, and
inflict significant financial losses on the institution in
the name of another person. For example, fraudsters can
copy adhar card information or bank credentials and get
the loan cleared in our name.

Spamming REMEMBER IT! \35'

You must have noticed when looking through | Thereisa hacker attack every 39 seconds

i
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your mailbox that there are numerous emails from unidentified email
addresses. Who is the sender of these emails and how did they get our
email addresses? The majority of contemporary browsers come with an
internal application that can recognise these emails and put them in
a different folder. Spam is the term for these unwelcome emails. They
are generally sent in large numbers for commercial

advertising. Spamming involves sending the same [ ﬁ Do You Know?
messages to email users all over the world in millions. | g,am accounts for 14.5 billion messages

Since spam may be used to spread malware such as | globally per day. In other words, spam

. . . makes up 45% of all emails.
trojan horses, viruses, worms, spyware, and coordinated

targeted phishing attempts, it poses a major security risk.

% CYBER SECURITY

Any computer that is connected to the internet is exposed to a wide variety of technological
dangers. We cannot ignore the reality that we constantly feel scared by the idea that a
computer genius may utilise dubious methods to learn crucial information about your
financial situation, interfere with it, or otherwise misuse it.This is where cyber security steps
in. Because it tries to protect sensitive data, computer security is crucial. It tries to protect
the confidentiality, integrity, and accessibility of important data kept on computers.

% USING PASSWORDS
It’s crucial to use passwords properly since they serve as your first line of security against
hackers and imposters.
Follow some of the tips given below.
Never disclose your password to a third party.
Never use the same password across all the accounts.
Make passwords that are simple to remember yet difficult to decode.

The password must include at least 12 characters, including capital letters, digits, and
symbols.

Make sure your devices have anti-malware software and are secure.

Use a fingerprint or “password” on your phone as well.

D
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e  SAFELY ACCESSING WEBSITES

Our lives have been completely transformed by the internet, which now allows us to read
the news, watch movies, conduct research, plan our vacations, buy and sell, and perform
a variety of other daily tasks. However, it comes with a lot of risks that could arise from
viewing a malicious website or unintentionally disclosing sensitive information. Malware,
which includes both spyware and viruses, may be involved.

Some points to keep in mind while accessing a website:
When using the websites, use common sense.
Verify the website’s address, contact information, and email address to ensure its
legitimacy.
The URL of the website might look authentic. Keep an eye out for slight spelling
variations.
Use the most recent versions of your browser and antivirus software.

Always keep in mind to log out of the website after finishing your transaction.

5 Kids’ 1IQ

Which things will you keep in mind while creating a password?

’ Let’s Recall

The ethical use of computing resources is ensured by computer ethics.
o  Hackers are those who take advantage of a computer network or system’s flaws.
o  Cyber Crime is any crime that is committed using the computer and the internet.

»  Stalking is the recurrent practice of unwanted monitoring or harassment with the
intent to manipulate or influence the victim.

e Any computer that is connected to the internet is exposed to a wide variety of
technological dangers.

o  Never use the same password across all the accounts.

7
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pskill Your Intellig

A. Fill in the blanks.

p—

5.

The ethical use of computing resources is ensured by .....................
Cyber ethic addresses the .................. dissemination of digital content.
.................... are those who take advantage of a computer network or system’s flaws.

Companiesand governmental organisationsbothsavetheir................ information
online.

Identity theft is a type of cybercrime when the culprit createsa ................ identity.

B. Write ‘T’ for True statements and ‘F’ for False statements.

1.

2
3
1.
5

Cybercrime is an act of crime in which a computer system is used to
commit an offence.

The Internet leads to the exchange of mobiles.

Hackers steal crucial information from a computer system. ()
Blocking someone who is stalking you on the web is a crime. ()

In spamming, millions of the messages are sent to different email users.

C. Answer the following questions.

1.

3.

Computer -8

What is Cyberstalking?




4.  What things to be kept in mind while accessing websites?

Your friend’s fake id has been created with his profile picture and details and the person
is asking for money from his friends.

As a friend, what steps would you take in this case?

Phoswop: s m % =
STRERGTH §I400 108




INTRODUCTION TO
APP DEVELOPMENT

At the end of this chapter, the students will be able to:
+ Know different types of apps.

+ Create apps based on the client’s requirements.

+ Develop an app using a thunkable app.

Guide students that they use various apps on a daily basis but have they ever thought about how
these applications are developed.

‘¥ Teacher’s
M/ Note:
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Hello Friends! Let us learn about
the development of apps.

The most common utility item today is the mobile phone. Everyone these days has access
to a cell phone.

People are using several brands of mobile phones. These mobile phones are little more than
miniature handheld computers; they are equipped with memory, storage, and processors,
as well as a keyboard, touchscreen, and output screen. Similar to how a computer has many
software applications installed in it, a mobile phone also has many applications placed inside
its memory. These apps do feature a distinctive User experience that has been masterfully
created by professionals.

Running many apps loaded on a computing device depends heavily on the operating system.
Due to the fact that a mobile phone serves as a computing device, every mobile phone has
an operating system as well. Apps are made to function on the various operating systems
that they employ.While iPhone apps may be used on iPhones that run iOS, Android apps are
designed to work on phones and tablets that run the Android & Let Me Answer
OS. Most of these apps can be downloaded easily from the

Google play store on Android phone or through the App store
on iOS.

Which app do you use often?

!%  TYPES OF MOBILE APPS

There are three main types of mobile apps, just as there are various operating systems for
mobile phones. Let’s learn about these three categories of mobile phone apps.

Native Apps

A native is a person who is connected to a place by birth or who was born there. Native apps
are created expressly for an operating system on a mobile device. As a result, you can create
iOS apps for mobile devices running the iOS operating system and Android apps for devices
running the Android operating system. Native apps are created with consideration for the
hardware requirements of a mobile device, which have different hardware requirements
than desktop computers. Numerous coding languages are used to create native apps.

®




LANGUAGES USED

Figure 9.1: Pros and Cons of Native apps
Advantages
1. Native UL
2. It can access the features of a device.

3. Itis faster and gives better performance.

Disadvantages
1. It is expensive to maintain.
2. Updates need to be downloaded.

3. Take up much space in the device.

Web Apps

Apps that can be used
with a web browser
are refer red to as Web LANGUAGES USED
apps. You don)t need HTMLS, C55, JavaScripl, Rubiy. etc
to download these
apps to your phone.
Even when we select

the install option,

all that happens is o
that we download a o
bookmark. The URL
link will enable easy

browser access to the
online application.

Figure 9.2: Pros and Cons of Web apps

Computer -8




Advantages
1. It can be used on all devices since it’s web-based.
2. Itis easy to maintain.

3. It doesn’t occupy space in the device.

Disadvantages
1. It always needs an active internet .
2. Itis totally dependent on the web browser.

3. It may not always integrate with device hardware.

Hybrid Apps

Web apps and native apps are combined to create hybrid apps. These apps can be loaded
on a device much like native apps and have a user interface similar to a web app. Apps that
are hybrids can be acquired from the iOS or Play stores. Hybrid apps have an app icon,
display responsive design, and assure fast performance. Although they look native, they are
essentially web apps that are made to work offline.

LANGUAGES USED

Figure 9.3: Pros and Cons of Hybrid apps
Advantages
1. Itis quicker and cheaper to make.
2. Loads fast.

3. Requires less code to maintain.

Disadvantages
1. It has less power than native apps.
2. Some features might not work on devices.

3. Since each element has to be downloaded, it is slower.

©
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CHOOSING THE RIGHT APP FOR DEVELOPMENT

1. Development Time

Web apps are the greatest option if you want to make an app that shouldn’t take too long to
design and your users are okay with using a browser.

2. Limited Resources

If you have a limited budget, go with a web app instead of a native app. You can convert your
application to the Native version after it gains user engagement.

3. Performance

Development of a Native app is the best option if app @ Let Me Answer
performance is your top priority. Native apps are effective | g, you ever noticed the name of the
in terms of performance and stability and may be readily | app developed while using any app?

customised.

40

o=

DEVELOPING YOUR FIRST APP

In the process of developing an app, each of the app’s component parts is first created, and
then the entire app is put together. Here, we will learn to create different components of an

app.
Let’s start by using the web application “Thunkable’ to build a basic user experience for an
app.

4 THUNKABLE APP

Thunkable is a web-based application that was first made available by Google and has an
integrated development environment. Anyone with basic computing skills can develop
Native apps that are based on Android and iOS . It has a GUI based interface which is very
similar to Scratch. It offers the feature of drag and drop, by which we can easily create an app
without writing any code.

Starting Thunkable app

Follow the given steps to start the Thunkable app.

Steps:
1. Inyour browser, type the following URL.

www.thunkable.com

?




2.

3.

’ L

HE . 1

& thunkable

ihard s oo

Realize your app idea, No Code

O progect, thees Crogs-peationm apps
Ho Coding,

s @ ﬂ"i'l‘.'-i

.........

fommedny  Dom By Paoeg g Sigsls E
N o
|
=
S Saram
\.h..lh-:rﬂln..

Figure 9.4: Thunkable App Interface

To begin, select the start button. You'll see the screen given below.

< C

) hupsy/xthunkable.com/login

w ® = @ &

E:
@ thunkable [
B““d your | G signinwith Google I
own apps : 4
for free &  Signinwith Apple E
with |
thunkable [ Signinwith emall
::::x':tier::zu tto account! Create one ‘I‘E
Beautiful and l
powerful mobila I:
apps. |

Figure 9.5: Sign in

Use your Google account to log in to the Thunkable application. The following page
will appear after you check in to the app with your Google account.

@
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@ thunkable

[P

Start Building -y

Figure 9.6: Start Building your App

4.  Select “Start Building” option. It will then display the Create New Project dialogue box,
as seen below. Add the required information and click on Create button.

Create New Project X

New Project Name:

project Name...

| Category (Optional) :

‘ Please select category (at most 6). |

m Everyone can access this project here!

ML 1y .'I'.- N

Tyitout []

i ."j..: '[ I B e RS Ak !_"'= h

R i .;?:’_ r <\ b A s “pr".- :.
. New Bethe firstto try our new drag and dropinterface

once | [

Figure 9.7: Creating a New Project

5. A webpage with a different toolbar and a demo screen will be shown as below.

=
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Figure 9.8: Thunkable App Development Interface

@ CREATING THE FIRST APP WITH THUNKABLE

Follow the given steps to create your first app.

Steps:
1. Scroll down to the Image tool in the design section.
e 3 -3
& Wy oo @ |

| = invisible Components

—

Drag ‘nvaitie Compenents here
|

Image L

Image tool - [a] imege
Glll Fricte Uierary
[E] Cameen '
§2 Borcode Scanner
BE imageRecognizer

& Arimaticn

Figure 9.9: Using the Image Tool
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2. Place the picture tool in the Layout Screen by dragging and dropping it there. The
layout screen will look similar to the illustration below.

Figure 9.10: Inserting Image

3. Choosea picture from the Image panel on the right side of the screen. Utilise the Upload
files option to upload an image from your PC.

4. Assoon as the picture has been added to the layout screen, you can drag and drop it to
reposition it.

8 ws B i ' m~ = -
LivaTask  Shase MakeCopy O {"3' Astet addad x
i ¥ YLPHG i
(] image1 ZBE
Sample Ay ¥
Pictern
'I'J..PN‘II-I ] X

| Phobure Bevle Mol
|
[
|

Heaght

Aldotute it

pL-)

Abpokety B

15

Figure 9.11: Positioning Image

5. Scroll down and choose the Label tool in the Design section. Drag it down and drop it
next to the picture.

Computer -8




Fig-ure 9.12: Inserting Label

7. Scroll down and choose the button tool in the Design
section. Drag it down and drop it just below the label.

8. From the button panel, click on the text option and
add text of your choice in the textbox. Various options
visible in the Button panel allow you to alter the Button
text’s style and appearance.

Our app’s user interface is now complete. The app interface,
which consists of an image, a label, and a button, can be seen
in the figure.

[0 Labell @0
Simple Adv >
Text
Label X
B 6. From the labell panel shown on the right hand
= side of the browser screen,click on the Text option
and add text of your choice in the textbox. You can
s also change the colour and size of the text using the
options given in the Label panel.
Calor
nirbuy| £l W
BackgroundColor
Font Style

<@

EOI Books

Figure 9.13: App Interface

.= Kids’ 1Q

Sandeep wants to build a mobile application, but he is aware of his limited resources
and is unsure of the type of app he should build. Help Sandeep choose the app he

should build while considering his constraints.

2
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@ Let’s Recall

The most common utility item today is the mobile phone.

«  Most of the apps can be downloaded easily from the Google play store on Android
phone or through the App store on iOS.

« Native apps are created expressly for an operating system on a mobile device.

o  Apps that can be used with a web browser are referred to as web apps.

o Hybrid apps can be loaded on a device much like native apps and have a user
interface similar to a web app.

The image tool is present in the .................... panel.
4. An ... helps the user to interact with an app.
5. app which saves development time.

B. Write ‘T’ for True statements and ‘F’ for False statements.
1. Native apps can be downloaded only from the iOS store.
2. A web app doesn’t need to be downloaded.

3. Operating systems play a crucial role in running the different apps

)
-
installed on a computing device. ()
4. Hybrid apps are a combination of both web apps and native apps. ()
A mobile phone can run without an operating system. ()

C. Answer the following questions.

1. State the difference between Native and Web apps.

----------------------------------------------------------------------------------------------------------------------------------------------




2. Write the reasons you’ll consider for selecting one type of app and not another.

Rahul wants to create an app for his business. He doesn't know much about creating
apps, just he is well versed with computing skills.

Suggest to him the platform he should use to create an app. Further, write the steps
to open it.

Team Work

*e [IH TI I I
L L 18

) LearnEnghsh %
Team up with your lab partner and Grammar
create an app on thunkable that enables
the students to learn the basic english R
grammar. Your app should include all the -
eight parts of speech.

£ senings




At the end of this chapter, the students will be able to:
+ Comprehend the significance of Audacity
+ Install Audacity

+ Know the user interface of Audacity
+ Import audio files in Audacity
+ Apply sound effects

Identify the logo of the following apps.

Assist students in finding the name of the above apps. Also, guide them about the Sound apps
which enhance the scene making it real, interesting and thrilling.

‘¥ Teacher’s
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! b Hello Friends! We will learn about
one of the most popular sound
editing apps called Audacity.

'ul_ . =

@ AUDACITY

Installing Audacity on numerous operating systems like [ ITTETTY T
Windows, Mac OS, and Linux enables you to edit and record | What is the literal meaning of
audio. Audacity was released on May 28, 2000, and since then | Audacity?

its popularity is on the rise.

g FEATURES OF AUDACITY

1. Free: Since Audacity is an open-source programme, it can be downloaded for free. It is
simple to obtain from the internet.

2. Cross-platform support: Audacity includes this feature, allowing you to install it on
devices running Windows, Linux, or Mac OS operating systems.

3.  Multi-Track Audio Mixing: You can quickly and easily trim a section from one audio
track and combine it with another using Audacity. Powerful audio tracks can be made
by combining many audio recordings.

4. Navigation Control and Zoom: Audacity has a user-friendly design; for instance,
when using painting software, you can utilise the zoom tool to improve your vision if
you wish to add colour to an area that is not immediately visible to you. Similar to this,
in Audacity, you can utilise the zoom tool to enhance a specific area of the track and
modify it using the numerous audio-enhancing effects that are offered by Audacity.

5. Speed Adjustments (Tempo): With a simple EBNE
mouse click in Audacity, you may quickly 25 Do You Know?

increase or decrease a track’s speed. To make a scene more thrilling and interesting,
a sound editor is used to create symphony and
desired effect.
g INSTALLING AUDACITY

As we all know, Audacity is a free open-source programme.
The most recent version of Audacity is readily available online.

®

32 Let Me Answer
What do understand by sound?
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Follow the given steps to install Audacity.

Steps:

1. Open the browser application on your computer and type the URL displayed below in
the address field to download Audacity.

www.audacityteam.org

2. Once you press enter, the following page will appear:

@ Audacity

Free, open source,
cross-platform

audio software

S DOWNLOAD AUDACITY e D Latest version = 239 . TT—

Figure 10.1: Audacity Home Page
3. Click on the download button and select the Windows option.

“ i hitps) e sedacityteamusng Na T8

Free, oper . A A e o e —

.
A P | 5 RIS O T ISR S A TS

B F T . KOM mn e R AQ b
CrDSS“I BTAIN : B nyemn St g ke - | i Bt e - W e e e St

audio software '

Developad Dy a grolp of vosunbeers ¢

Figure 10.2: Audacity Windows Download
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4. Open the Audacity installer on your PC by going to the downloads folder. Selecting
your preferred language will set off the installation process. After choosing your desired

language, press the OK button.

SelectSetuP Language ==

Select the language to use during the
installation:

[Engiish v

Lo Cancel |

Figure 10.3: Selecting Setup Language
5. 'The welcome screen for the setup process will appear; select Next to continue.

€ Setup - Audacity

Welcome to the Audacity Setup
Wizard

M This will install Audacity 2.4. 1 on your computer,

It is recommended that you dose all other applications before

Audacity. ===

Click Next to continue, or Cancel to exit Setup.

Figure 10.4: Setup Welcome Screen

6. After reading the licence agreement, press the Next button.

@




=) Setup - Audacity - X

Information
Please read the following important information before continuing. ‘:i

When you are ready to continue with Setup, didc Next.

&udadty' is free, open source software for recording and editing ~
sounds. It is available for Mac 05 X, Microsoft Windows, GNU/Linux,

and other operating systems. Learn more about Audacity. . Also check
our Wiki and Forum for more information.

License: Audacity is free software. You may use it for any personal,
lcommercial or educational purpose, including installing it on as many
different computers as you wish. Audacity is licensed under the terms
of version 2 of the GNU General Public License (GPL) as published by the
Free Software Foundation. The full text of the license is also available

when running Audacity, via the Help menu > About Audacity... command
> GPL License tab.

<tock [ Net> ][ concel |
Figure 10.5: Licence Information

7. Set the installation path at this time. To modify the installation directory, simply retype
the path or press the Browse option.

&b Setup - Audacity

Select Destination Location
Where should Audacity be installed?

Setup will install Audadity into the following folder,

To continue, ciick Next. If you would like to select a different folder, dick Browse,

C:\Program Fles (x88) \Audadt | Browss...

Atleast 62.4 MB of free disk space is required.

Figure 10.6: Selecting Installation Destination

Click the Next button if you are satisfied with the preset installation path.

o
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8. The following step is to help you to enter your specific installation options, such as how

you want Audacity to look on your computer once it has been installed.

=) Setup - Audacity

Select Additional Tasks
Which additional tasks should be performed?

Selact the additional tasks you would like Setup to perform while instaling Audadty,
then click Next.

Additional shorbouts:
[ Create a desktop shortout

] reset Preferences

Figure 10.7: Additional Shortcut

Click the Next button after making your selection for the preference.

9. Audacity is now prepared for installation; at this point, you can decide whether to stick

with the preset options for the installation or alter them. To alter the preferences or to
continue, click the back button or the Install button, respectively.

=) Setup - Audacity

Ready to Install
Setup is now ready to begin instaling Audadty on your computer. Q

Chick Install to continue with the instalation, or cick Badk if you want to review or
change any sattings.

Destination location:
C:'¥Program Fies (x86)\Audacity
Additional tasks:
Additional shortouts:
Create a desktop shorbcut

Figure 10.8: Ready to Install
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10. On your computer, the setup will extract and install the necessary files.

&) Setup - Audacity

Installing
Please wait while Setup installs Audadty on your computer,

Creating shortcuts...
C:Wsers'\Public\Desktop\Audadity. Ink

Figure 10.9: Extracting Files

11. To complete the installation, click the Finish button.

b Setup - Audacity =

Completing the Audacity Setup
Wizard

W Setup has finished instaling Audacity on your computer, The
application may be launched by selecting the installed
shorteuts.

Audacitys =

] Launch Audacity

Figure 10.10: Completing Audacity Setup

Computer -8
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The Welcome screen will appear as shown below.

Auadacity

Audacity 2.4.2

How to get help
These are our Support methods:

» Qulck Help - if not installed locally, view online
» Manual - if not installed locally, wview online
» Forum - &sk your question directly, online.

More: Visit our Wiki for tips, tricks, extra tutorials and effects

Don't show ths againat startup oK

Project Rate (Hz] Snap-T : =
PR . - nohoamopopoos® DoRoomasionasT

00 h00 mO0O0 s*

Figure 10.11: Audacity Welcome Screen

REMEMBER Qﬁj
Audacity features a user-friendly interface that is | Audacity was started by Dominic Mazzoni

essentially the same across all operating systems. and Roger Dannenberg in the fall of 1999 at
Carnegie Mellon University.

g AUDACITY INTERFACE

Menu Bar Tools Toolbar Recording Meter Toolbar
e e - —
bin Ldi feli Yaw Towpped Diew Gewmn Fes Aaeyp - fosh s
Transport Toolbar 5 i B (= A . = & SYoomtwmmmm o o 5 4| @5 = & o = = a5 s
. n B % 2 4 X0 =4 w~ 9angia
Device Toolbar : et RS ms——

Unpinned Play/ e —— . S e e e e e e
Recording Head !

Track Control
Panel

Timeline Scrub Ruler Audio Track

Selection Toolbar Time Toolbar Status Toolbar

Pt Sl (3 | Smac-Ta T el Bed ol Sy

wM - tm - [FVRVORIEEAEY: [FENRVRAT Hu.-: Em h00m0O0 s

Figure 10.12: Audacity Interface
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@ RECORD AUDIO USING AUDACITY

We are all aware that in order to capture audio, a working microphone must be connected
to, or at the very least built into, the computer.

Follow the given steps to install audio in audacity.

Steps:
1. Choose a recording device for audio from the device toolbar.
MME v & Microphone (Resitek High v | 2 (Stereo) Recor v #{1) Spesker/HP (Resltek High [ v
V.10 40 10 20 30 40 5.0 6.0

Figure 10.13: Selecting the Audio Recording Device

2. Check the recording level on the monitoring metre to make sure Audacity and the
microphone are working together. The intensity of the signal will be stated.
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Figure 10.14: Monitoring Meter
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3. When everything is prepared to record audio, click the red button on Audacity’s main
toolbar. The recording will begin after this.

4.  Press the stop button to stop the recording.

5.  When you touch the stop button, Audacity will show you the recording.

?
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Figure 10.15: Audio Recording

You can hear the most recent audio recording by clicking the play button.

P>

@ SAVING AUDIO RECORDING
You can save your recording as a Project or Export it to the most popular audio formats
using Audacity’s many different saving options.

Follow the given steps to save the recording.

Steps:

1. Select Export from the menu options after clicking the File menu, and then choose the
required option from the list of supported audio formats.
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Figure 10.16: Saving Audio Recording
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2. It will show the Export Audio dialogue box. Click the Save button after entering the file
name in the File name textbox.

3. The Edit Meta tags dialogue box will be displayed. Add additional information about
the track in various fields and click on the OK button.

e » RECORD AUDIO USING AUDACITY

You can add a track from your computer’s hard drive and modity it thereafter adding it to
Audacity. However, you must import the track first before you can begin modifying it.

Follow the given steps to import a track from your computer’s hard drive.

Steps:

1. Select Import from the menu selections by clicking on the File menu, and then choose
the Audio option.

Look in:

1
<5

Recent Places

Desktop
=}l
Libraries

A

=

Computer

G

Metwork

Q Select one or more files

, Record by Ravneet mam

MName
[#]1
1$]2
£]3
94
[9]5
9|6
917
918
919
|$]10
#]11
|$]12
4113
914
|$]15
|#]16
|#]17
|#]18
|#]19
|#]20
[#]21
9] 22
923

File name:

Files of type:

-

-

o F @
Date modified
19-Apr-22 11:44 AM
19-Apr-22 11:44 AM
19-Apr-22 11:44 AM
19-Apr-22 11:44 AM
19-Apr-2211:45 AM
19-Apr-2211:45 AM
19-Apr-2211:45 AM
19-Apr-22 11:46 AM
19-Apr-22 11:46 AM
19-Apr-22 11:46 AM
19-Apr-22 11:46 AM
19-Apr-22 11:47 AM
19-Apr-22 11:47 AM
19-Apr-22 11:47 AM
19-Apr-22 1:44 PM
19-Apr-22 1:45 PM
19-Apr-22 1:45 PM
19-Apr-22 1:45 PM
19-Apr-22 1:45 PM
19-Apr-22 1:46 PM
19-Apr-22 1:46 PM
19-Apr-22 1:46 PM
19-Apr-22 1:46 PM

Type

MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound
MP3 Format Sound

Size
1,526 KB
1,545 KB
1,840 KB
1122 KB
1,664 KB
1,833 KB
1,050 KB
1,391 KB
1,563 KB
1,767 KB
1,522 KB
1,632 KB
1,442 KB
2,007 KB
1,502 KB
1,796 KB
1,833 KB
1,408 KB
1,528 KB
1472 KB
1,709 KB
1,820 KB
1,663 KB

X5

-

COpen

| Al iles

)

[ Cancel ]

Figure 10.17: Select one or more files

2. Find the track you want to import in the select one or more files dialogue box. When
the desired track has been chosen, select Open to bring it into Audacity.

Computer -8
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Figure 10.18: Import Track

g WORKING WITH MULTIPLE TRACKS

Multiple tracks may be necessary to work with while doing sound editing. Let’s say we want
to edit the sound for a scene from a movie where characters are conversing while crossing a
busy street. We are aware that this scene will include character talk in addition to the regular
street noises that one hears when walking. We might like to add some background music
to increase the scene’s impact. Working with numerous tracks at once is necessary for all of
this.

The act of combining numerous Audacity tracks that are playing simultaneously into a single
track is known as mixing. When playing or exporting, Audacity automatically combines
tracks, but it can also manually combine a number of tracks into one within the project.

Follow the given steps to work with multiple tracks.

Steps:
1. From the file menu, use Import option and import two different tracks that you wish.
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Figure 10.19: Multiple Tracks
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2. Use the I selection tool from the Tools toolbar and select the portion you want to delete

from the first track.
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Figure 10.20: Working of Selection Tool

3. You will see that the selected portion is now highlighted with a different colour. To
delete the selected portion, click on the delete key. Observe that the selected portion
has been removed from the track.
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Figure 10.21: Deleting Track Portion
4. Repeat step3 to delete the selected portion in the selected track.
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5.  You will notice that the timeline of Track Audacity will look the same as the picture

given below after deletlng the selected portlons
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Figure

10.22: Tracks Audacity Timeline

6. Lets select the Timeshift tool and place the remalnlng part just after track one.
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Figure 10.23: Working of Time Shift Tool
Press the Play button to listen to the track.

@ APPLYING EFFECTS

There are numerous effects available in the majority of photo editing and presentation tools,
including PowerPoint software, that may be used to improve the appearance and functioning
of various items. For instance, we can easily apply various animation or transition effects to
various objects like text and photos in PowerPoint. Similar to this, we can also use Audacity’s
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many audio effects to enhance the sound quality of an entire track or just a selected section
of it.

We'll quickly go through how to add some audio effects to a track today.

Steps:
1. Utilizing Audacity Timeline’s import function, add a track.

2. Choose the section of the track where the effect should be applied using the Selection
Tool from the Tools Toolbar. Press the Ctrl-A key combination to add effect to the
entire track.
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Figure 10.24: Applying Effects

3.  Now select the Echo menu option by clicking on the effect menu. The chosen section
of the track will immediately receive the Echo effect.

Using the instructions above, you can apply a variety of different effects to your audio file.

i Kids’ IQ

Karan is working on two tracks; he wants to add the remaining track from track 1 to
another track in the timeline after deleting a piece of track 1. Provide Karan with the
tools he needs to complete this task.

J
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@ Let’s Recall

Audacity was released on May 28, 2000 and enables you to edit and record audios.
o  Audacity is a free open-source programme.

e  You can quickly and easily trim a section from one audio track and combine it with
another using Audacity.

o The act of combining numerous Audacity tracks that are playing simultaneously
into a single track is known as mixing.

« Audacity was started by Dominic Mazzoni and Roger Dannenberg.

~
A. Fill in the blanks.

1. Audacity was released on May .....................

2. Audacityhasa ... design.

3. In Audacity, you can utilise the ............... tool to enhance a specific area of the
track.

4. Theactof ................ numerous Audacity tracks that are playing simultaneously
into a single track is known as mixing.

5. option is used to add a track to the Audacity timeline.

B. Write ‘T’ for True statements and ‘F’ for False statements.
1. Audacity is a Paid software. ()
2. Audacity is a cross-platform app. ()
3. It allows edit of only one track at a time. ()
4.  Play button is pressed to play the track. ()
5 )

You can’t delete the portion of the track once it’s saved.

C. Answer the following questions.

1. What is Audacity?

..............................................................................................................................................




2. How can we install Audacity on our computers?

Using several Audacity sound effects, Kanku has produced a new track and altered
its audio. She wants to save this track in MP3 format on her pen drive. Aid Kanku
in saving the MP3 version of the track.

Team up with your partner and record an audio of your favourite song using
Audacity and apply effects to it. Once done, play it in the class.




Model Test Paper

A. Tick (V') the correct option.

1.

1.
2.
3.

4.
5.

In battle zones, military operations entail ......................

(a) landmine detection D (b) theif detectlon D
(c) cyberbully detection D (d) attack detection D
We can run computer instructions repeatedly using the ... without
having to keep writing the same ones.
(a) concept of aloop (] (b) concept of copy ()
(c) concept of detection D (d) concept of a protection D
The subscriber totally outsources the ........................ and ... they require,
such as hardware and software, under an IaaS arrangement.
(a) storage and resources D (b) guide and guidelines D
(c)data and data science D (d) technology and law D
Most .....coviiiiiinnnl. providers give storage options. These storage services are
immensely popular among users.
(a) data services D (b) cloud service D
(c) information services D (d) Electronic computers D

B. Fill in the blanks with correct words.
The size of a network can be expressed by the ..................... area they occupy.
Setting up a firewall system aids in the fight against .................. and ...
Computer networks can be characterized by their ... as well as thelr
The majority of cloud providers offer ...................... options.
A is created specifically for a given organization, and only that

C.

D.

organization is permitted to use or access it.

Write ‘T° for True statements and ‘F’ for False statements.

1.

2.
3.
4.

This command causes the loop to skip the remaining portions of its body
and to retest its condition right away before updating the loop variable.
Traversal is the process of accessing elements in a sequence one at a time.
Companionship: providing company to elderly individuals.

Robots are artificial agents that do not behave in the real world.

a8as

Answer the following in one word.

ARl

What is cloud computing?

What is a microcontroller?

Write about any two cloud services.

How can we create a query using the query wizard?

What considerations are to be made before choosing cloud service?
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" Model Test Paper

A. Tick (v') the correct option.

1. The many sensors thatare attachedtoan................. allow it to sense and receive.
(a) Arduino O (b) Srirduino D (c) Arvindo O (d)BeprindroO

2. Arduino is an open-source hardware and software company, project, and user
community that designs and manufactures ...................
(a) single-board microcontrollers D (b) double-board microcontrollers O
(c) Macro controllers D (d) Mixed controllers O

3. A query is a simple question that you ask to find specific information from

(a) database O (b) data security D (c) data collection O (d) data form O

4. A service gives subscribers access to different applications (apps).

(a) SaaS cloud D (b)Saving cloud
(c) PaaS cloud D (d) Google Drive O
B. Fill in the blanks with correct words.

1. The goal of the ... field of robotics is to investigate how to create
efficient and intelligent robots, which have ... implanted in their bodies
to function similarly to a human’s five senses.

2. People that exploit security holes in a computer network or system are known as

3. The . of digital content is addressed by cyber ethics.

4. Identity theftisa type of cybercrime in which the culprit createsa ................ identity.

C. Write ‘T’ for True statements and ‘F for False statements.

1. All of this simply means that we have the option to select a certain cloud
service based on our needs.

2. Theterm “cloud computing” refers to a range of services that are available
via subscription.

3. A tiny computer chip called Arduino is mounted on a double-integrated
circuit.

4. Code for Arduino can be written in a variety of languages, including
Java, C, C++, and Python.

D. Answer the following questions.

1. Identify two drawbacks of cloud computing.

2. What is Cloud computing?

3. What function does IDE serve?

4. What should be considered when viewing websites?
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